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Introduction

The batch demo application demonstrates the capabilities of the OPN2002/3/4 to store barcode data in a file and retrieve this file from a local PC. The files can
either by retrieved by using the OPN2002/3/4 as an USB Mass Storage Device (MSD) or can be received using the NetO protocol by using USB-VCP and/or the
CRD2000 multi cradle (for OPN2002 only). Since the OPN2002/3/4 terminals do not have a display to show any instructions, this demo application implements
a user interface that consists entirely of using just the two keys to scan barcodes. This brief setup guide describes all features as well as handling instructions.
More product details, additional support and more configuration options to customize this application to your own preferences (by using the Universal Menu
Book) will be updated at www.opticonUSA.com

Batch Application Capabilities

The following features are currently supported:
e Scanning and storing of barcodes into a database file on the internal RAM disk
e Retrieving the barcode data file via a local PC or laptop using the NetO protocol by either USB-VCP or the CRD2000 multi cradle
e Using the OPN200/3/4 as an USB Mass Storage Device (MSD) to retrieve the barcode data file
e OSE Universal Menu Book support to configure all barcode decoders, prefixes and suffixes, read modes and various other options
e Storing of configurations in non-volatile memory to allow all settings to be restored after a reset
e Configuring output format of the database file
e Software upgrading by USB-VCP or the CRD-2000 multi cradle (RS232) using Appload

System Requirements

Minimum Required OS Version

For USB-VCP and CRD2000 support, this demo application requires OS version:
e OPN2002: RBGV0212 (or higher)
e OPN2003: RBFV0212 (or higher)
e OPN2004: RBIVO0O7 (or higher)

For USB-MSD (Mass Storage Device) support, this demo application requires the OS version:
e OPN2002: RBGV0220d (or higher)
e OPN2003: RBFV0220d (or higher)
e OPN2004: RBIVOOO7 (or higher)

To check the currently installed OS versions, it is possible to use Appload (Select: ‘Utilities’ > ‘Show software version’). To check the currently installed application
version, it is also possible to transmit both the OS and application version by USB-VCP by reading the ‘Z1’ menu label (see Universal Menu Book).

NetO32

This demo application can use Opticon’s NetO32 host PC application to be able to transfer files from the OPN to a PC or laptop. This application can be downloaded
from the link below. The minimum required NetO32 version is 2.07.

http://ftp.opticonusa.com/Downloads/Net032.zip

Appload

To be able to install this application onto your OPN, you will need to have Appload installed on your PC. Make sure you have the latest version of Appload, which
can be found on our web site. Please read the ‘Loading of software’ section of this manual before downloading any software on the OPN.

http://ftp.opticonusa.com/Downloads/Appload.zip

Software Updates

In the future, additional features, and updates are likely to be implemented into the OS and this application. To find out if there are software updates available,
please check our web site (www.opticonUSA.com).

All available software and documentation for the OPN2002/3/4 can be found at www.opticonUSA.com under Companion Scanners.

—1—
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Customizing the OPN

Selecting the USB Interface (VCP or MSD)

This batch demo application supports three methods of retrieving your barcode data file from the OPN:
e USB Mass Storage Device (MSD)
e USB Virtual Com Port (USB-VCP) using NetO32 to retrieve the file
e CRD2000 multicradle using NetO32 to retrieve the file (OPN2002 only)

After loading this software on the OPN for the first time, the application will automatically be reset to USB-VCP default.

If you would like to use your OPN as a USB Mass Storage Device, scan the label below.

use-msp default | AN MO

For more information on how to use your OPN as USB Mass Storage Device, see section Using the Mass Storage Device (MSD) Interface.

To switch back to USB-VCP default (i.e. to load software), scan the label below.

use-vepdefautt | I I ANAN

For more information on how to use your OPN as USB-VCP, see section Using the USB-VCP and CRD2000 Interface.

Independent of whether you configured your OPN2002 as Mass Storage Device (MSD) or as USB-VCP, it’s always possible to transmit your barcodes using the
CRD2000 multicradle in combination with the NetO32-file transfer PC application.

Universal Menu Book Support *

The OPN supports the reading of various configuration options that can be found in our Universal Menu Book**. This makes it possible to customize your
application without having to actually change the source code of this demo software.

The OPN supports (most of the) menu options listed in the following chapters:
1. Defaults (see the supported default label listed above)

3.1 Enabling/disabling readable codes

3.2 Setting of fixed, minimum and maximum lengths of readable codes

3.3 Code specific options (most options are supported except 2D symbology options)
4.1 Case conversion

4.2 Set prefixes

4.3 Set suffixes

5.1 Read modes, add-on wait modes

5.1.1 Multiple read reset time

5.1.2 Quiet zone options (margins)

5.2 Read time options

5.4 Redundancy

5.5 Positive and negative barcodes

6.1 Buzzer settings

6.2 Good read LED options

7.1 Diagnostics

* This demo application does not implement any of the OPN2002’s Bluetooth capabilities. A Bluetooth demo (RFG35317) for the OPN2002 is available on our
web site.

** The Universal Menu Book can be downloaded from the following link:

http://ftp.opticonusa.com/Downloads/Universal%20Menu%20Book.pdf
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Barcode Database File

All scanned unique barcodes are stored in a database file with fixed length records. Besides the barcode data, the quantity, serial number of the OPN and a date/
time stamp can be stored.

The default format of each record in the database file is:

<Barcode (40 chrs)>,<Quantity (6 chrs)>,<serial #>,<hh:mm:ss>,<dd/mm/yyyy>

Example:

8710841030181 , 12,003278,14:41:03,23/11/2009
8710841090246 , 2,003278,14:41:04,23/11/2009
9780131103627 , 1,003278,14:41:00,23/11/2009

The filename of the database is ‘DATA.TXT’, which is stored on the OPN. Depending on the selected interface, this file can be retrieved from the OPN as a file from
a Mass Storage Device or transferred by USB-VCP or CRD2000 using the NetO32 application.

When using the NetO32 application to retrieve the file, any transmitted data will be appended (by default), so all the data of multiple OPNs will end up in a single
database file on the local PC.

The resulting database file can be imported into various applications via a comma-separated (CSV) file.
To customize the output format of the database file, please see Appendix A.

If no quantity field is specified in the output format, then each bar code will be stored in a separate record.

Scanning Barcodes

This OPN firmware application uses the trigger button to enable the laser barcode scanner.

If a barcode is read using the trigger key, a good read beep is produced and a green LED is shown. The barcode is then stored in the database with a quantity of
‘1. If the same barcode is scanned again, the quantity is incremented by one each time.

To decrement the quantity of a barcode that is already in the database, the barcode should be scanned using the small delete key rather than the trigger key. A
short, good read beep is produced and an orange LED is shown.

If a barcode is scanned using the delete key that is not present in the database or that already has a quantity of ‘0’, a low error beep is emitted and a red LED is
shown.

Negative quantities are, by default, not supported, but when using the ‘Negative quantities’ option (see Appendix A), it is possible to scan negative quantities
of barcodes. When a specific barcode has a negative quantity, the LED color changes from green (add) or orange (subtract) to red on a successful scan and the
sound becomes slightly lower.

Deleting the Database

It might become possible that your OPN has a full or corrupt RAM disk or contains unwanted barcode data that you want to delete from the OPN. In this situation,
it is possible to read the label below to erase all files from the RAM disk.*

Format DY N R AR RO A 1

When using the OPN in USB-MSD mode, it is also possible to delete the file manually using a file browser.

* Note: If the OPN battery loses power, then the OPN will not immediately lose saved data. However, a few days afterwards, if the battery is not charged, all data
on the RAM disk will be lost. Also, the internal clock will reset if the battery is completely drained. The PC host application Appload (see Appload) can be used
to reset the correct date and time.
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Installing Drivers

USB-VCP Drivers

To be able to communicate with the OPN200x terminals using USB-VCP, you will need to have the USB driver installed on your PC. This driver can be downloaded
from the following link.

http://ftp.opticonusa.com/Downloads/USB%20Drivers%20Installer.zip

USB Drivers Installers.exe USB-VCP driver for Windows 2000 , Windows XP (32bit) & Windows Vista/7 (32bit)
USB-VCP driver for Windows XP (64bit) & Windows Vista/7 (64bit)
USB driver for the CRD2002

After installing the USB driver, you can connect your OPN to USB using the mini-USB cable. Windows will then automatically install a virtual COM port on your
PC, which must be selected in various applications, like Appload, Hyperterminal and Neto32.

CRD2000 Cradle Drivers (OPN2002 Only)

The CRD2000 cradle works either via USB or via RS232 and both interfaces do not require any configuration.

The USB-VCP driver pack mentioned above also automatically installs the USB drivers for the CRD2002 cradle.

Using the Mass Storage Device (MSD) Interface

When the USB-MSD interface has been selected, the OPN will behave like a portable mass storage device when it is connected to USB.
Any scanned barcodes will be stored in a comma separated file called ‘DATA.TXT’, which can be copied/moved from the OPN using a file browser.

Due to the limited amount of memory (RAM) inside the OPN, the size of the file system is rather small, about 32kB on the OPN2004, 125kB on the OPN2003, and
about 900kB on the OPN2002. This is ample space for storing barcodes, but not for using the OPN as a portable hard drive.
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Using the USB-VCP and CRD2000 Interface

Configuring the Host PC or Laptop with Net032 " Net032 - United =S

File Protocol Tools Language Help

When the USB-VCP interface has been selected, the barcode database file can be transmitted to a
remote PC or laptop using NetO32. The data is transmitted by either a mini-USB cable (USB-VCP)
or by the CRD2000 multi cradle (OPN2002 only). To be able to receive the files on the host, you will File progress:
need NetO32 to be installed. The latest version of NetO32 can be downloaded from our website (see
Net032). More information about additional Neto32 features that are not described in this manual
can be found in the NetO32 help file.

@ POLLING ID: pREEEAY

Total progress:

Status log:
£(2013-02-11,01

Screenshot of the NetO32 main window

Using the CRD2000 Preferences
2] 5232 7. RS232
= Protocol
Setup 3 Download
4 Upload ~COM port Parity ~ IrDA Device

When using the CRD2000 multicradle, certain configurations have to

. . - Polling and Timir COM1 - & No I Nooe
be made to correctly synchronize multiple OPN2002s that all want to | |5 K Miscellaneous | C 0dd & Litelink compatible
transfer a file to the host at the same time. B Appearance .  Even " Tekram compativle
: . . P @ tog ByteSize ;
First of all, the R$232 settings have to be correctly configured. Besides 115200 IRU-1300

57600  Tbis

selecting the correct COM-port of the CRD2000, you will also have to 28400 @ 8bis

select the correct baud rate and other RS232 settings. The default NetO32
settings are shown in the screenshot below. The setting(s) that must be
changed for this application are noted in a list immediately below the
screenshot.

e COM port: chosen by Windows at the time the OPN is first
connected to Windows via USB (or COM1 if using RS232). See
Windows Device Manager under the heading ‘Serial Ports (COM
& LPT)’ for a list of such devices attached to your computer.

e Baudrate: 115200

9600 Stop bitis)
4800 @ 1bit

el T R e N
g

2400 " 2bits

RS232 settings in NetO32 when using the CRD2000 cradle

Terminal IDs reieeeey
- RS232 B Polling and Timin,
When using the NetO-protocol with a multi-cradle, the use of terminal | | & protocol P: g
IDs is mandatory to make sure that all files will be transferred without 3 Download 05s
conflicts and errors. & Upload

M 2 ) Polling and Timii

Since the OPN2002 does not have a system menu in which a terminal | |=-f& Miscellanecus 'VTma‘;to = :
ID can be configured, each OPN2002 has its own unique serial number B3 Appearance

stored in non-volatile memory. This demo application uses this unique (i Log
serial number as the terminal ID. The serial number of OPN2002s is
printed on the back of the terminal, which makes it easy to add the serial
numbers in NetO32.

The six digit serial numbers of all your OPN2002s will have to added at
‘“Tools > Options > Polling and Timing > Terminals to Poll”.

When using the CRD2000, do not configure a Poll Speed faster than
0.5s because once an OPN2002 is communicating to the host, the other
OPN2002s will be temporarily muted for 250ms by the CRD2000 to avoid
data collisions. For this reason, an OPN2002 responds to a poll after a
random time ranging between 280ms and 480m:s.

Screenshot of Polling and Timing settings
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Using the Mini-USB Cable

When using USB-VCP and the mini-USB cable to retrieve your data from the OPN, the R$232 configuration of NetO32 is limited to selecting the correct COM-port
of your OPN in the RS232 configuration window of NetO32.

However, when using the mini-USB cable, it is not possible to keep NetO32 running in the background due to the fact that the USB COM-port will not be present
on your system until you have physically connected your OPN to your USB port. Also, it is not recommended to disconnect or to reconnect your OPN without
having stopped the NetO-protocol first. For these reasons, it is easiest to place a NetO32 configuration file on your desktop that downloads the data from the
OPN once and then immediately closes again. This can be done by selecting the following three options in Net032:

e Protocol > Polling and Timing > Protocol type: Single
e Protocol > Polling and Timing > Protocol type: Quit after single run
e Miscellaneous > Appearance > Run protocol on start

The correct sequence to retrieve the data from the OPN using the mini USB cable is connecting your OPN to the USB port, double-clicking on the Net032
configuration file and then disconnect the OPN from your PC when desired.

Do not forget that your OPN needs to be regularly charged as well.

Loading Software on the OPN

The following chapter will describe how to load new software onto the OPN.

Important note: when installing a new operating system on the OPN, any barcode data left on the device might be lost!

Software Codes

All OPN terminals run an operating system (OS) and an application. Both the OS and the application can be loaded by a small PC application called Appload, which
can be download from our web site (see Appload).

The OPN terminals use an OS version that contains a unique three letter code. Before you try to load a new OS on an OPN terminal, you have to know which OS
file (i.e. RBFVxxxx.hex) must be loaded on your terminal.

In the table below, you can find the software codes for the OPN200x terminals.

Terminal (o} Application
OPN2002 RBG RFG*
OPN2003 RBF RFF*
OPN2004 RBI RFI*

* |t is often possible to load OPN2002 applications on the OPN2003 and vice versa, because the hardware is mostly the same (with the exception of the Bluetooth
capabilities and cradle contacts which are only present on the OPN2002).

Loading Software Using the Mini-USB Cable

To be able to load software on the OPN using the mini USB cable, first make sure you have selected the USB-VCP interface (the MSD interface does not support
software updates). Also, make sure you have the USB-VCP driver installed on your PC.
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Loading Software on the OPN2002
To load a new OS or application onto the OPN2002, you will need a mini-USB cable (which is supplied with the OPN2002) or the CRD2000 cradle.

To load an OS or application file, please follow the instructions below.

USB Cable e Connect the terminal to your PC or laptop using the mini-USB cable
e Start Appload and select the (Virtual) COM port of your OPN2002 in Appload
e Select the OS or application file in Appload using File > Download

Multi-Cradle Currently, it is not yet possible to load software on multiple OPN2002s at the same time. Therefore, it is mandatory to place
only one OPN2002 in the cradle at a time. To do this, follow the instructions below.

e Place one OPN2002 in the cradle

e Start Appload and select the COM port of the CRD2000 cradle

e Select the OS or application file in Appload using File > Download

e Wait until the downloading has finished before inserting another OPN2002 in the cradle

IMPORTANT (!):

If you try to load multiple OPN2002s simultaneously with Appload, the end result will be OPN2002s with faulty software that
will need to be restored by loading the software again (one at a time). See the ‘trouble shooting’ section for more information
about loading software on OPN2002s with faulty or crashing software.

Bluetooth <Currently not supported>

Loading Software on the OPN2003/4

To load a new OS or application onto the OPN2003/4, you will need a mini-USB.

Please follow the instructions below.

USB Cable e Connect the terminal to your PC or laptop using the mini-USB cable
e Start Appload and select the (Virtual) COM port of your OPN2003/4 in Appload
e Select the OS or application file in Appload using File > Download

Other Available OPN2002 Applications

Besides this batch demo application, there are three other OPN applications available on our web site that might fit your specific application better.

Software V3510x, V3727x: OPN2001 Simulation Application
This application turns the OPN2002/3/4 into an OPN2001 compatible batch scanner. V3510x is for the OPN2002/3 and V3727x is for the OPN2004.
Besides USB, any stored barcode data can also be retrieved from the OPN2002 by using Bluetooth.

Use this OPN application in combination with the OPN2001 Demo application for Windows or develop your own application using the SDK that’s available for
the OPN2001.

Note: when planning to use the OPN solely as a standard OPN2001 (without Bluetooth or custom applications), please note the following (hardware) differences:

e When rarely used, the battery of the OPN2002/3 runs down quicker than the battery of the OPN2001. The OPN2002/3 can operate normally for about
30 days under low use conditions.

e The OPN does not support laser aiming (laser dot)

e The OPN cannot change its scan angle to shorten the laser line

e Unlike the OPN2001, the OPN2002/3 will lose its time and date within four or five days after the OPN2002/3 becomes non-operational due to a drained
battery, which is sooner than the OPN2001. A drained battery will cause the time to be reset to 1-1-1970 00:00. If the OPN2002/3 is not regularly used, it
might be necessary, before retrieving any barcode data, to compare the current time to the time which is read from the OPN2002/3. If the retrieved time
does not match the time of the PC, then the correct time can be sent to the OPN2002/3 and incorrect time/date stamps of barcode data can be corrected
using the difference between the time of the OPN2002/3 and the PC.
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Software V3531x: OPN2002 Default Bluetooth Application

This application turns the OPN2002 into a Bluetooth barcode scanner, which currently supports the following features:
e Connecting to a remote device and transmitting its data using a Bluetooth virtual COM port (VCP) or as a Bluetooth Human Interface Device (HID)

e Making the OPN2002 connectable (as slave) and discoverable to allow a remote device to connect with the OPN2002 and transmit its data using a
Bluetooth virtual COM port (VCP) or as a Bluetooth Human Interface Device (HID)

e (Limited) Opticon Universal Menu Book support to configure barcode decoders, prefixes and suffixes, read modes, buzzer/LED settings, change Bluetooth
configurations and switch between HID or VCP Bluetooth interface

e Use of the trigger and clear key to connect, disconnect, make discoverable / connectable and reconnect
e iPhone / iPad compatibility

Note: source code will be available for editing by using the provided SDK.

Software V3553x: Advanced Bluetooth Application
This application has been developed for the OPR3301 barcode scanner, but it is also compatible with the OPN2002.

This application is very similar to the Bluetooth demo application (V3551x) listed above, but supports more of the Bluetooth options that are listed in the
Universal Menu Book.

This application is recommended when the OPN2002 is used as a replacement for the previous generation OPL2724 / OPL7724, and when barcode memorization
is desired such as when the OPN2002 has lost its Bluetooth connection or is out-of-range.

Note: no source code will be available for editing.

Troubleshooting

Since the OPN does not have a display, it also does not have a system menu to resort to when you have installed a crashing application that prevents you from
loading new software on the OPN200x.

For this reason, the OPN200x has a few escape mechanisms to allow you to restart, halt your application and/or install new software. This can be very useful in
case the OPN200x has crashed or is constantly restarting due to a crashing application.

Restart Mechanisms

Automatic The OPN has a watchdog timer to determine whether the OS is still running or has crashed. This watchdog will cause the OPN
to restart after three seconds if the OS has crashed. This watchdog timer will not cause a restart when only the application has
crashed.

Manually The OPN has a manual restart mechanism that allows you to restart in situations that the OS is still running, but the application

has crashed. In order to activate this mechanism, press and hold the trigger or delete key for at least 20 seconds. After the OPN
has sounded the restart beep, you can release the key to complete the restart.

Note: on the OPN2004, you must push both the trigger and clear key to halt the device. After the beep, if you release the trigger
key, the application will be halted, and you can reload it with Appload. If you release the clear key, the OS will be halted, and
you can reload it with Appload.

Halting the Application
e First, make sure your battery is not drained and your mini-USB cable is not connected to the OPN.
e Second, restart your application using one of the two restart methods listed above, while keeping the trigger key pressed.

e Finally, while keeping the trigger key pressed, insert the mini-USB cable into the OPN to halt the application.

If successful, the LED of your OPN should now be blinking orange. You should now be able to load new application or OS software.

Halting the Operating System
e First, make sure your battery is not drained and your mini-USB cable is not connected to the OPN.
e Second, restart your application using one of the two methods listed above, while keeping the delete key pressed.

¢ Finally, while keeping the delete key pressed, insert the mini-USB cable into the OPN to halt the operating system.

If successful, the LED of your OPN should now be blinking red. You should now be able to load a new OS.
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Version History

RFG35410 First release December 7, 2009
RFG35411 Added configurable database formatting December 14, 2009
RFG35412 Fixed very slow storing of barcodes February 3, 2010
RFG35413 Preliminary addition of USB-MSD June 10, 2011
RFG35414 Added USB-MSD and updated manual June 17, 2011
RFG35415 Fixed USB-MSD issue June 29, 2011
RFG35416 Small LED bugfixes March 3, 2012
RFIS0940 First release OPN2004 December 26, 2012

Please check our web site at www.opticonUSA.com to see if there are updates available for this application, the operating system, NetO32 and/or this manual.

Appendix A: Database Formatting

The default output format of each record in the database file is:

<Barcode (40 chrs)>,<Quantity

(6 chrs)>,<serial #>,<hh:mm:ss>,<dd/mm/yyyy>

However, this application allows you to customize this format to make it suitable for your own application.

The following aspects of the output format are configurable. Read the configuration barcodes on the following pages to select the various options.

Date format

16 date formats are supported (see following page)

Time format

Two time formats are supported (hh:mm:ss and hh:mm)

Field separator

The field separator is the character that is used to separate the various fields of a database record.

Seven different separators can be selected.

Enable/disable delete key

By default, the small delete key can be used to remove a previously read barcode from the database or reduce
its quantity by one. By disabling the delete key, stored data cannot be deleted in this way.

Barcode field size

By default, the barcode field size is 40 characters long, but this can be changed between 1 and 99 characters by
reading two configuration labels on the following page to specify both digits of the desired size.

Quantity field size

By default, the quantity field is six characters long, but this can be changed from one to eight characters if
desired.

Delete record if quantity=0

By default, a record is deleted if a barcode in the database (with a quantity of one) is read using the delete key.
However, if you desire to keep a record of all delete actions, it is possible to leave the record with a quantity of
‘0" in the database by disabling this option.

Negative quantities allowed/
now allowed

By default, you can not delete a barcode that is not present in the database. However, for some purposes, it can
be useful to be able to read them anyway to specify a negative quantity.

Field output sequence

Each record can contain up to five fields (barcode, date, time, quantity and serial number). The output sequence
can be customized by reading up to five labels on the following page.

By not specifying a quantity field, each barcode will be stored separately in the database. The database also
will not be sorted and in case a barcode is read using the delete key, the last occurrence in the database will
be deleted.

It is not allowed to not specify a barcode field in the output sequence.

Note: when changing the field sequence, make sure you have downloaded the existing database file from the
OPN or otherwise formatted the RAM disk.
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* = Default

Field output sequence
Field 1 Field 4
IN AW Barcode* | NIIANMUMNINN Barcode
I LI Quantiey | JHLNNHAWTARIIN Quantiey
QNN seiate - RN NOWIAARININ- seriat
LA HALNN e RN NOWARARIN Time®
[N ate | DHLUAURTAR T Date
AN <none>
Field 2 Field 5
I LW HARNN Barcode | LN NIMIMANIIN Barcode
I LI NN Quantiey | JHINTAWTINN Quantiey
DO HRNNAND seriat# QUL NOMINERONN- seriat o
NIRRT vime  DHEUANRRORIN Time
LA HNARD Dace RN NANHANGINN Date
[N <none> - THNNTNINTHITN <None>
Field 3
I LI AAAN Barcode Field separator
AN Quantiey | | 0TI comma
UL AN seria = NN <as>
UL TAURRIR) Time I semicoton
LU RN Date W <ces
IATNATENERIH <None> W Piee 1
ERTHIAL <cr>
NI siash <7
R =
IR zero o

RFG35416, RFIS0940
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Quantity field size (1-9) Date format

LM O WA - oo-mm-vyvy
LRI IRIATT 2 I wan-DD-vvvy
LRV ARITON 3 W oo-mm-vy
IR 4 WA ma-p0-vy
LR WL yyyy-mm-oo
R

7 DD-MM
IARINMNIN = W mm-po
NN o W oo/mmzvyyys

WM nama/oR/vYYY
IMETHTH oo/mmyvy

Delete key DT wm/o0vv
IO Enablea® NN vevv/mam/oo
INETN Disable I vv/mm/oo

IR oo/mm

WAL Mw/00

Negative quantities

IRHTLINELNA Anowed
IHTINHTI Not Anowed-

Barcode field size (0-99)

ot WA 1 1111111111 T S
IARTITNAN o | B

[N enabiec IANTITING 2o | B0 2
INTHITININ orabtec NI =0 | HnLImnI 3
IARTITI =0 | GANNIMNI

Time format H IHI H II|I||I|I| III >0 || |I|| || " I"I| I" || >

60 6

A U o | {0
- ARTITING =0 | HANNINNNNIN s

N ANTITNNG =0 | B0 o




